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Overview

• Introduction to Pmv
• The Dashboard Panel
• Advanced Rendering
• Vision Programming



Not Yet Another Molecular Viewer
• Component based architecture

Pmv is underlying:
- ADT
- Raccoon
- PyARTK
- ePmv
- Continuity GUI



Unique Design Features

• Written in Python (i.e. Fully scriptable)
• Automatic command log generation
• Customizable commands (loaded dynamically)
• Programmable through visual programming
• Dynamically extensible data structures
• Advanced rendering capabilities
• Amination capabilities



Powerful 3D graphics



Rendering: Volumetric data
•The Pmv interface to Volume



Rendering Volumetric data



Rendering: 3D Labels



Rendering Modes: Large Images



Rendering Modes: NPR



OpenGL Scissors



Support for point symmetry



Vision: scripting Pmv



Animations
• Scripted in Python
• Frame grabbing
• Using Vision
• Using Scenario

375 lines of Python code

Interactive Frame grabbing



Pmv: simple animations



Animation: Vision
• Extensible through visual programing



Amination: Scenario



Scenario



Installing Pmv
http://mgltools.scripps.edu/downloads
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http://www.scripps.edu/~sanner/collab/TutorialData.zip



Installing Pmv



Starting Pmv

The installer placed 3 
icons on the desktop.
To start Vision double 
click on the Vision 
Icon.

The installer created 
the pmv shell script 

$MGLROOT/bin/pmv.

Where MGLROOT is 
the folder you chose 
to install the software



Starting Pmv
Menu

Button Bar

3D Viewer

Dashboard

Sequence Viewer



Exercise: start Pmv
Task: loading molecules into PMV

1 – start Pmv
2 – load the molecule hsg1.pdbqs is located in Desktop/TutorialData

using the menu entry File -> Read Molecule 



Exercise: Loading molecules
Task: alternatives for loading molecules into PMV

1 – right click on “All Molecules” in dashboard
2 – File -> Read Molecule 
3 – File -> Recent Files
4 – File -> Import -> Fetch From Web
5 – using command line: pmv mymol.pdb

NOTES: 
1 – multiple molecules can be selected in the file browser
2 – wildcards can be used on the command line (e.g. pmv –i test*.pdb)
3 – using a pdb id on the command line will fetch the protein from 

web unless it is in the cache



Exercise: Right click menu

Task: Show the color ID of hsg1

1 – right click on “All Molecules” in dashboard
2 – Show molecules color ID 

1 – Right click on elements in the dashboard usually displays a menu
2 – The “All Molecule” menu allows showing/hiding all molecules and

add a colored line in the dashboard to help identify molecules
3 – Double clicking on molecule names show/hides the molecule 



Exercise: Pmv mouse

Button

Mod

Left Middl
e Right Wheel

None Rotate

Translate 
left/right (X) 
and up/down 

(Y)

Zoom

Shift Add to 
Selection

Translate in/out 
(Z)

Ctrl
Remove 

from 
Selection

Center on Pixel



Exercise: Pmv key bindings
Task: learn PMV viewer 

keystrokes
Ke
y

Action

R Reset view

N Normalize – scale so all visible molecules fit in 
the Viewer

C Center on the center of gravity of all the 
molecules

D Toggle on/off Depth-cueing (blends molecule 
into background farther away) 

T Toggle between transform root (i.e. scene) and 
transform the Viewer’s current object

A Auto Depth-cueing (set fog to cover depth of the 
current scene)

L Toggle on/off OpenGL Lighting (turns on/off 
photorealistic lighting)

O Toggle Ambient Occlusion



Pmv dashboard

Dashboard

Resize
Widget

Minimize/
Maximize

Widget

Commands Matrix

Molecules Tree

Button Bar

Selection
Entry

Divider



Exercise: Pmv dashboard
Task: dashboard

1 – hoover mouse over glyphs and read tool tips
2 – expand/collapse molecule tree
3 – make the dashboard wider
4 – move the divider right and left. Notice the labels in the molecule tree change
upon mouse button release
5 – minimize dashboard
6 – restore dashboard
7 – find the button that sets the dashboard width to show all columns and restore 
dashboard’s default size



Dashboard Command Matrix
Select Lines Label ColorSurfaceRibbonBalls &

Sticks
CPK

Notes: 
- Tool tips on all command buttons



Dashboard Molecule Tree

Molecule Tree

Molecules: can be expanded
to show chains, residues, atoms

sets: cannot be expanded
represent molecular fragments

From the molecules loaded in Pmv

Create a set using 
the current selection



Dashboard Command Buttons
On/Off Buttons 

Notes: 
- No state
- Left mouse toggles on/off command mode
- Right mouse click to display command specific menu
- Green button triggers command (i.e. select, display lines, etc …)
- Red button triggers inverse of the command (i.e. deselect, un-display lines, etc…)
- Used for sets (i.e. current selection, user defined sets (see below))

Display lines for all molecules
Left click to:

Undisplay CPK for the current selection



Dashboard Command Buttons
Percentage Buttons 

- Left mouse click to activate button
- Right mouse click on green button click to display command specific menu
- Show percentage (i.e. 50% of hsg1 is displayed as lines and part of chain A is 
selected)
- Buttons cycle from “partial” to “full”, to “empty”, to “full” etc.
- Used for molecules in tree (i.e. hsg1) 

Un-display lines for chain A

Left click to:

Display lines for Chain B



Exercise: Display Lines

1 – un-display lines for Chain A. NOTE partial line display feed back on hsg1
2 – left click 2 times on Lines for hsg1. NOTE how the button and display 

cycles from partial to full to empty
3 – un-display lines for chain B
4 – Right click on lines for chain B
5 – change the line width to 4

Task: display lines



Exercise: Display Balls and Sticks
Task: geometry quality and rendering options

Quality changes the number of polygons used 
0 automatically selects the tessellation

Toggle Front and Back
Faces rendering on/off

Points Lines Shaded Outlined Color



Exercise: Display Balls and Sticks

1 – display B&S for chain A
2 – right click on B&S for chain B and check Balls to modify spheres radii

Task: display balls & sticks

Quality changes the number of polygons used 
0 automatically selects the tessellation



Exercise: Display CPK

1 – display and un-display CPK for chain A
2 – right click on display CPK for chain B to display option panel
3 – scale CPK spheres

Task: display CPK

Radius = offset + atom radius*scale



Exercise: Display CPK

1 – Right click on CPK for hsg1
2 – check “By Property” button
3 – select atomic property temperature Factor
4 – set scaling to 0.02 

Task: display CPK



Exercise: Display Ribbon

1 – display ribbon for Chain A. 
2 – right click in ribbon for chain B

and select ‘ellipse’ for he shape
3 – un-display all ribbons

Task: display Ribbons

Task: Beaded Ribbons

1 – use menu entry Compute -> beaded ribbon. 
2 – un-display all lines
3 – un-display all ribbons



Exercise: Display Surfaces

1 – display surface for hsg1
2 – un-display surface for hsg1
3 – turn ambient occlusion on ‘o’
4 – right click on surface for hsg1 and set probe radius to 3.0
5 – change rendering style of front faces to outlined
6 –compute surface with various densities
7 – display surface for chain A only (NOTE the surface is open)
8 – turn display of back faces on in rendering tab
9 – display lines for hsg1

Task: display surfaces



Exercise: Closed surfaces for chains

To close the surface:
1 – right click on the “hsg1” label in the molecule tree
2 – select “Make sets for chains”
3 – compute surface for the 2 created sets

Task: display closed surfaces



Dashboard Command Buttons
Menu Buttons 

- Left mouse click to display menu



Exercise: Label Residue
Task: use label menu on Arg8

1 – select ARG8 (type ::ARG8 <Return> in Sel.: box)
2 – display S&B for current selection
3 – click in Label triangle icon for current selection
4 – Select “Residue” in Level
5 – select “name” in properties



Exercise: Labeling options

Notes: 
- If you click more properties the label is extended
- Use Clear labels to remove all label at the current level
- Use the advanced tab to modify labels
- Use “custom” property in Basic to customize any label



Exercise: Color Menu

Notes:
- Only displayed representation 

(lines, CPK, etc) are shown
- Coloring schemes are applied as

they get selected provided at least
one geometry is select

- The “By secondary structure” scheme
only appears if the molecule(s) we 
are coloring have a ribbon



Exercise: Color Menu
Task: Apply different coloring schemes to various representations

1 – display Balls & sticks for chain A
2 – display CPK for Chain B
3 – color Balls and Sticks for chain A

By atom type
4 – color CPK for chain B by Polarity
5 – display ribbon for chain A
6 – color ribbon by secondary struct.



Exercise: Color By Property
Task: color CPK by temperaturFactor

1 – display CPK 
2 – Display color menu for protease
3 – check CPK in Representations in the Basic Panel
4 - Select “By Properties”
5 – select temperatureFactor
6 - Apply



Exercise: Color Palettes
Task: Modify the first color in the color by molecule palette

1 – Edit -> Color Palettes -> Edit Color by Molecule
2 – click on color 0
3 – select new color in color chooser
4 - Restore default

Make Default would make this change permanent
by writing it into the _pmvrc file



Exercise: Color Editor
Picking a custom color will extend the color editor
Custom colors survive the PMV session



Pmv selection

Set selection level

Current selection
description

Clear selection



Pmv selections

• Visual feed back of selected 
atoms on all representations



Creating selections
• Pmv menu commands and dashboard entry 

“current selection” operate on selection
• Pmv has various way to build complex selections

– Shift left click and drag in 3D Viewer
– Dashboard selection column and sel.: entry
– Selecting residues in sequence viewer
– Menu Select ->



Creating selections
• Shift Left Click an drag to add to the selection
• Ctrl left click and drag to remove from the 

selection



Creating selections
Notes: 
– clicking without dragging will only select the one atom 

closest to the viewer. Dragging will draw a rectangle 
and select all atoms falling inside the rectangle.

– Selection is perform at the current selection level. If 
the level is residue, selecting a single atom will select 
the whole residue



Creating selections
• Left click in Selection column of the Dashboard

– Toggle selection state for the item

Task: create selections using the dashboard at various levels

1 – select hsg1
2 – deselect chain B
3 – clear the selection
4 – set the level to Atoms
5 – Shift click drag a box over part of a chain
6 – change the level to residues
7 – use the current selection entry to display CPK



Pmv selections

• Dashboard selection menu
• Clear selection
• Invert selection within fragment
• Deselect fragment
• Select subsets of atoms
• Select special residues
• Select atoms Displayed as
• Edit selection:

– Expand selection within fragment
– Select around selection within fragment



Pmv selections
• Expand selection and select around

1 – load molecule indinavir.pdbq
2 – clear selection
3 – display lines only
4 – right click on select hsg1  -> Select Around
5 – increase the range to 5.5 (more blue spheres appear)
6 – accept



Pmv selections
• Powerful selection mechanism using regular 

expressions:
• moleculeRE:ChainRE:ResiduesRE:AtomsRE
• wildcards such a (e.g. *) and ranges (e.g. PRO1-ARG8)

• Available in the Python shell and dashboard
– Examples:
“:::” will select all Atoms in all Residues in all Chains in all Molecules in Pmv
“Mol1::” will select all Residues in all Chains in molecule Mol1
“Mol2:B::” will select all atoms in Chain B in molecule Mol2
“Mol1, Mol2:::C,N,CA,O” selects backbone heavy atoms in molecules Mol1 and Mol2
“::ALA35-THR45” selects a range of residues
“::ARG*:H*” all the Hydrogen atoms in Arginine 

http://mgldev.scripps.edu/docs/mgltools/1.5.6/Selection%20Strings.htm



Dashboard User Sets

• Shortcut for operating on selections



Sequence ViewerShow/Hide

Chain IDs
Left click to jump to

Right Click to expand/collapse

Gaps in numbering
Non standard Residues

(lower case full name)

Selection feedback



Exercise: selections
Task: explore sequence viewer

1 – load 1jff.pdb
2 – collapse chains and expand them
3 – select amino acids using sequence viewer 

(Left click on un-selected residue and drag)
4 – de-select amino acids in sequence viewer

(Left click on selected residue and drag)
5 – select in 3D Viewer

Task: manual alignments

1 – load 1sa0.pdb
2 – Ctrl-Shift-Left click on Residue 1jff:A:61 and drag to the right

to align with residue 1sa0:A:61
3 – Left click on amino acid and drag a box to select across proteins



RMDS/Superimpose

Right click on 
molecule name



RMDS/Superimpose



RMDS/Superimpose



RMDS/Superimpose



Scenario Animations: snapshots



Scenario Animations: moves



Scenario Animations: color



Scenario Animations: sequence



Scenario Animations: sequence
Task: create an animation

1 – load hsg1 and indinavir
2 – hide indinavir
3 – display hsg1 as ribbon colored by secondary structure
4 – create a snapshot of only 1 frame add it to the sequence
5 – create a fly-in from the left add it to the sequence
5 – zoom in to active site create a snapshot and add to sequence
6 – create a rock and add to sequence
7 – create a snapshot with arg8 visible as S&B (rendering only)

and make it start with previous
8 – add a rock while fading in indinavir as a surface
9 - fly out
10 – record the animation

NOTE: Scenario animation snipets get saved in the session file



Scenario Animations



Scenario Animations
Task: create a simple animation using scenario

1 – load hsg1.pdbqs from Desktop/TutorialData
2 – undisplay lines
3 – display ribbon and color bur secondary structure
4 – center molecule and take snapshot
5 – edit snapshot to use 1 frame
6 – add snapshot to animation
7 – create fly in motion and add to animation
8 – Load indinavir and display S&B
9 – create snapshot with zoom on indinavir and add to animation
10 – create rock motion and add to animation
11 – create snapshot to zoom back out and add to animation
12 – create fly out motion and add to animation





Example: 1uw6



Exercise: selections
Task: get structure and get familiar with it

1 – get pdb file 1uw6 from web (File -> import -> fetch from web)



Exercise: selections

5 4

32
1

6



Exercise: selections
Task: Keep a single ring by deleting the 3 others

1 – select chains A-E in dashboard
2 – invert selection on the molecule
3 – right click on current selection and “delete selected atoms”

Task: visualize 5 chains in the ring and show ligands

1 – color molecule by chain (carbon only)
2 – select ligands in molecule
3 – display CPK for ligands



Exercise: selections
Task: keep only chain A and B

1 – select chains C-E in dashboard
3 – right click on current selection and “delete selected atoms”

Task: delete ligand in chain B

1 – suggestions ?

Task: focus on ligand in chain A

1 – select ligand in Chain A
2 – create user set
3 – Right click on set name and “Show me in 3D Viewer”



Exercise: selections
Task: make sets for neighboring side chains and interface water

1 – select ligand set
2 – “select around” in protein with cutoff 4.0
3 – create “binding with water” set

4 – select “binding with water” set
5 – de-select water
6 – create “binding” set

7 – select “binding with water”
8 – de-select “binding” set
9 – create “water” set



Exercise: selections
Task: compute surface

1 – select protein
2 – de-select ligand
3 – de-select binding with water
4 – de-select water
5 – make set “bulk”
6 – compute surface for bulk set



Example: 3kfr



Example: 3oya



Feedback

email: sanner@scripps.edu



3D Visualization



3D Visualization



3D Visualization: GUI overview

Bind Mouse to
transform

Operations assigned
to mouse buttons

(changes with modifiers)

When checked 3D
Xforms apply to root

Geometry objects
hierarchy

Root geom
parent of all

geometries and
current object

Master geom
for all geoms

of a given molecule

Geoms created
by Pmv cmds

for that molecule

Reset Xform of 
current object

Fit the scene 
in the view

Set rotation
center to center

of the scene



3D Visualization: GUI overview
Select property panel to show

Object
property

panel



3D Visualization: GUI overview

Camera
property

panel



3D Visualization: GUI overview

Clipping planes property panel

Lights property panel


